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1 Introduction

This program allows a Macintosh computer to control a simple single-beam spectrophotome-
ter via a serial port connection. The original version was written more than ten years ago
by Jing Dong Liu, then a graduate student in the Biology Department at the University of
Utah, for a biochemistry lab course. More recently, we have written an updated version,
MacSpec II, using REALbasic, an outstanding software-development tool described below.
In addition to its use in the teaching lab, we use the program extensively in our research.

1.1 System Requirements

MacSpec II will run on any Macintosh computer with a PowerPC processor. The computer
must either have a serial port or a serial port adaptor. Both USB and PCI card adaptors
are available.

Two separate versions of MacSpec are provided: one for the classic Mac OS and one
for OS X (named MacSpec II Carbon). The two versions were built from the same source
code, but, because the operating systems handle the serial port differently, they had to be
compiled individually. We have only carried out minimal tests with the OS X version, but
it seems to work well. Unlike the classic Mac version, it does not lock out other processes
during a kinetics run.

1.2 Features

The major use of MacSpec is for kinetic experiments in which absorbance measurements are
made at timed intervals from one or more cuvettes. The computer sends commands to control
the spectrophotometer and records the data it receives back. If the spectrophotometer has
a multi-cuvette holder that can be controlled via the serial port, the program can collect
data from several cuvettes simultaneously. This is particularly useful for enzyme kinetics
experiments.

Features of the latest version, MacSpec II 1.1, include:

1. Timed data collection

2. User specified total run time and time intervals (subject to the limitations of the
spectrophotometer)

3. Automatic plotting of kinetic data.

4. Linear least squares fitting of data.

5. Printing data tables and graphs.

6. Export of data in tab-delimited text files.

7. Computer-control of basic spectrophotometer functions, including setting the wave-
length, turning lamps on and off and moving the cell positioner.

8. Versions for the classic Mac OS and for OS X.
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9. A demo mode so that you can play with the program and see how cool it is even if you
don’t have a spectrophotometer!

Eventually, we would like to add the capability for wavelength scanning.

1.3 Spectrophotometers

MacSpec is intended to be used with relatively inexpensive spectrophotometers that can be
controlled via a serial port. There are several such instruments on the market, typically with
prices in the range of $5,000 - $10,000. Using a computer with a simple spectrophotometer
can be a cost-effective way of adding a great deal of functionality, provided that suitable
software is available. Unfortunately, while many instruments can be controlled via a serial
connection, each has its own command set which must be incorporated in the software.
The current version of MacSpec can control four different spectrophotometer models. Sadly,
three of them, the Spectronic 2001, Pharmacia Ultrospec III and Spectronic Genesys 8, have
been discontinued by their manufacturers. The fourth is the Beckman DU 600 series and
is currently in production. The program is written in a modular way so that it should be
relatively easy to modify it for use with other instruments, so long as the instrument has a
serial port and the command set is available. Usually, this information is provided in the
manual for the spectrophotometer or can be obtained from the manufacturer. We would be
happy to provide the source code for MacSpec and might even be able to help a little with
the modifications.

1.4 About serial connections

The serial connection is one of the oldest bits of computer technology that is still with us,
if for only a while longer. It was originally designed to connect computers or terminals to
modems, but it has also has also been used to connect computers to each other, to printers
and to a variety of peripheral devices including scientific instruments. The good thing about
a serial connection is that it is relatively easy to write software to transmit data over it. The
worst, probably, is the fact that it is one of the least standardized standards in the computer
industry. Different connectors are used, and, even worse, different equipment manufacturers
have different ideas about how the connector pins should be wired! Finding a cable with the
right kind of connector at each end is no guarantee that it will work. The serial connection is
also relatively slow by modern standards, but that is not at all a problem for this application.

To the extent that they follow any standard, most instrument manufacturers will specify
that the serial port is an “RS-232” connection. None of the current Macintoshes have have
serial ports, but there are adaptors that allow serial devices to be connected via the USB
port found on the newer machines. These, and the serial ports found on older Macs, are not
actually RS-232 connections, but are RS-422 ports, and use the small circular DIN-8 plug.
Fortunately, the two standards are similar enough that it is usually possible to get the Mac
to talk to a serial device, though it may take some trial and error and some soldering.

More information about serial port connections is available at the Goldenberg lab web
page: http://www.biology.utah.edu/goldenberg/.

3



1.5 USB Connections

As noted above, none of the current Macs have serial ports, so you will have to use a USB-
serial adaptor to use MacSpec with one of these machines. (On the other hand, controlling
a spectrophotometer is an ideal application for an older Mac that is being pushed aside for
one of the new shiny machines.) There are several adaptors on the market, each with its own
driver software. Our limited experimentation indicates that some work better than others,
but we have had pretty good luck with the Keyspan Twin-Serial Adaptor.

At some point, instrument manufacturers may stop incorporating serial ports and start
using USB for connecting to computers. While this will certainly represent technological
progress, it’s not clear whether or not it will actually make things better for Macintosh users.
Each USB device requires its own driver, which is a relatively deep part of the operating
system, so it may be much more difficult for users to write their own software to control
these devices. Support from the manufacturers may be limited to PCs.

1.6 About REALbasic and PlotCanvas

The current version of MacSpec was written using REALbasic, a computer language and de-
velopment environment that is quite similar to, and somewhat compatible with, VisualBasic,
a widely used Microsoft product. Like VisualBasic, REALbasic uses a graphical interface
that makes it relatively easy to build an application with its own sophisticated interface. The
language is object-oriented and bears almost no resemblance to the original Basic language.
Programs written in REALbasic are compiled to create stand-alone applications and can be
compiled for either the Classic Mac operating system or for Mac OS X, making REALbasic
one of the easiest ways to create native OS X applications. The “professional” version of
REALbasic can even compile applications for Windows. So, it should be relatively easy to
port MacSpec to Windows, though we haven’t tried it.

To add the ability to plot kinetic data, we used and adapted a REALbasic “class” for
graphing written by Rob Frohne of Walla Walla College. With Rob’s permission, we are
making our version of PlotCanvas available for other REALbasic programmers. Our version
can be found on the Goldenberg lab web page, http://www.biology.utah.edu/goldenberg/,
and Rob’s original version is available at
http://www.wwc.edu/~frohro/REALbasic/rEALbasic cartesian plot c.htm.
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2 Connecting the Hardware and Setting up the

Software

2.1 Hardware Connection

To use MacSpec, the Macintosh and spectrophotometer must be connected via an appropriate
serial cable. The three spectrophotometers currently supported each require a different
connection. Although special cables could be wired for each, it is probably easiest to use the
standard “hardware handshaking” cable intended for a modem and adaptors as described
below. Those who want the gory details of how these connections work are referred to the
separate documentation on serial port connections.

Most Macintoshes with serial ports have two ports: one labeled “modem” and the other
“printer”. If possible, use the modem port, since the printer port is not intended for two-way
communication at higher rates.

If you are using a newer Macintosh without serial ports, you will need to use either a
USB-Serial adaptor or an accessory board with a serial port. We have only tried a couple
of USB adaptors and, of these, the Keyspan Twin-Serial adaptor worked best. You will also
need to install the appropriate driver software. This software should allow you to identify
one of the serial ports on the adaptor as the “modem” port. It is probably best to use this
port for the connection to the spectrophotometer.

2.1.1 Disclaimer

We do not have any professional credentials in computer hardware or serial interfacing. We
cannot accept any responsibility for damage to your computer, your spectrophotometer or
your sanity.

2.1.2 Pharmacia-LKB Ultrospec III

This spectrophotometer is relatively easy to connect; all that is necessary is the hardware
handshaking cable. This cable has a male DIN-8 connector at one end and a male DB25
connector at the other, with the pins of the connectors wired as shown below:
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The DIN-8 connector is a small round plug with 8 pins and connects to the Macintosh (or
a USB-Serial adaptor), and the DB25 is a wide flat connector with 25 pins. Only 9 of the
pins of the DB25 connector are actually used, and some cables include only these pins.

Be aware that not all cables with a DIN-8 connector at one end and a DB25 connector
at the other are actually wired this way! Some cables, in particular, are intended to connect
a Macintosh to a printer, rather than a modem, and are wired differently. These cables will
not work for this application.

2.1.3 Beckman DU 600 series

These spectrophotometers should be connected using the same hardware handshaking cable
as described above for the Ultrospec III.

2.1.4 Spectronic 2001

To connect this spectrophotometer, you will need the same cable as described above and two
additional components:

1. A “null modem” adaptor. This is a small box with a male DB25 connector on one side
and a female DB25 connector on the other. The pins of the two connectors are wired
together as follows:
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2. A male-to-female DB25 “gender changer”.

Connect the DB25 end of the cable to the female end of the adaptor, attach the gender
changer to the male end of the adaptor and then attach the assembly to the male DB25
connector of the spectrophotometer.

2.1.5 Spectronic Genesys 8

Connecting this spectrophotometer is somewhat more complicated and involves a bit of
soldering. This instrument uses the smaller DB9 connector rather than the DB25 for its serial
port. A relatively simple method for making the connections uses the following components:
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1. Standard Macintosh hardware handshaking cable as described above.

2. A Serial Jumper Box with DB25 connectors (Part no. 276-1403 from RadioShack).
This is simply a small box with two DB25 connectors (one male and one female) and
provisions to wire the pins together in any combination. The connections are made by
soldering jumper wires to a printed circuit board.

3. A cable with a male DB25 connector on one end and a female DB9 on the other (to
fit the spectrophotometer).

4. A male-to-female “gender changer” that allows the jumper box to be connected to
both cables.

The DB9-to-DB25 cable is relatively well standardized and readily available. But, make
sure that it is wired as follows:

DB9 Pin DB25 Pin

1 8

2 3
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7 4

8 5

9 22

The connectors of the jumper box should be wired as shown below:
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After wiring the box, attach its female connector to the DB25 end of either of the cables and
then use the gender changer to connect it to the other cable. Connect the DB9 connector to
the spectrophotometer and the DIN-8 plug to the Macintosh.

2.2 Software settings

MacSpec stores information about the spectrophotometer model being used and the serial
port settings in a preference file (MacSpec prefs), located in either the Preferences Folder in
the System Folder (System 9 and older) or the individual user’s preferences directory (OS
X). If the multiple users feature of OS 9 is turned on, the preference file is stored in the
individual users’ preferences folders. The first time the program is started, it will ask you to
identify the spectrophotometer you are using:

Simply choose the appropriate spectrophotometer name from the drop-down menu and click
the Save button.

You will likely then see an error message:

Click OK. At this point, make sure that the spectrophotometer is on and connected, and
then choose the item Serial Port Settings from the Edit menu. This will bring up a dialog
box from which the various parameters for the serial port can be set.
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From this dialog, you can select the serial port to use for the connection (preferably
the modem port) and set all of the standard serial port parameters. For all of the spec-
trophotometers currently supported, both of the flow control (hardware handshaking) op-
tions should be turned on. For the other settings, each of the three spectrophotometers has
its own set of default settings, and clicking the Use Defaults button will set the parameters
for the currently selected spectrophotometer type. To varying degrees, these parameters can
be adjusted on the different spectrophotometers, so you should to make sure that the spec-
trophotometer settings match those set in the dialog box. The settings that can be adjusted
by the user are as follows:

• Beckman DU 600 series - The two hardware handshaking options in MacSpec, CTS
and RTS, should be turned off, and the XON/XOFF options on the spectrophotometer
should be turned off. The other communications settings can be changed using the
spectrophotometer’s interface. You can either set these to match the defaults from
MacSpec or change the settings in the program to match the spectrophotometer’s
settings.

• Spectronic 2001 - Nearly all of the settings can be changed using DIP switches on the
serial interface board. You can either set these switches to match the defaults from
MacSpec or change the settings in the program to match the hardware settings.

• Spectronic Genesys 8 - There are no adjustable settings. Just use the defaults for this
spectrophotometer.

• Pharmacia-LKB UltroSpec III - The baud rate can be set from the keypad on the
spectrophotometer. Make sure that this setting matches the one set in the program.

After setting the various parameters, you can test the connection by clicking the Check
Connection button. You should see a dialog box that reports the time delay between when
the test was initiated and the when computer received an appropriate return signal. If the
spectrophotometer does not respond correctly, recheck all of the connections and settings.

After the correct settings have been established, click the Save button. The settings will
now be stored in the preferences file, and you shouldn’t need to change them again unless
you change something on the spectrophotometer.
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3 Controlling the Spectrophotometer from the

Computer

The Spec menu contains several commands for controlling the spectrophotometer:

These functions are detailed below.

Wavelength... This command brings up the following dialog box:

When the dialog box first appears, it should contain the wavelength that is currently set
on the spectrophotometer. To change the wavelength, enter the new value and click OK. If
the chosen wavelength does not lie within the range of 190 to 950 nm, an error message will
appear.

Cuvette This menu item has a submenu that allows the user to set the position of the cuvette
holder, if the spectrophotometer has a multi-position holder.

Lamps This menu has a submenu that allows the user to turn on or off the UV or visible
lamps. Not all of these functions are implemented on some of the spectrophotometers.
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Check Connection This command sends a signal to the spectrophotometer and waits for a
return message to confirm that the connection is working. A dialog should appear reporting
the time required for a response or an error message indicating that no response was obtained
after 2 sec. If the test fails, check to be sure that the spectrophotometer is on, the connection
to the computer is correct and the serial port settings are correct.

Demo Mode This command allows the program to be run in a demonstration mode, in
which a kinetics run can be simulated without a connection to a spectrophotometer. In this
mode, the data collection times are entered in the data table, rather than absorbance values.
The following dialog box appears to confirm the command:

When a kinetics run is started in demo mode, another dialog box will appear to ask the user
whether or not to proceed with the run in demo mode.
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4 Setting up and Running a Kinetics Experiment

The major function of MacSpec is to control kinetic experiments in which absorbance mea-
surements are made at regular time intervals from one or more cuvettes. As the run pro-
gresses, the data are entered in a table, and after the run is completed the absorbance values
are automatically plotted as a function of time.

4.1 The Data Window

When the program is first started, a kinetics data window will open automatically:

This first window will be setup for a kinetic run that uses the maximum number of cuvettes
available with the selected spectrophotometer and to collect a total of 6 six data points.
These parameters can be changed as described below.

In the data window, each column has two headings. The top heading indicates the cuvette
number and is fixed. The second heading has default entries “sample 1”, sample 2”, etc.
These entries can be changed to more meaningful labels. Simply click on the current entry
to make it active for editing.

Clicking on the “Comment” button will open a dialog box in which information about
the experiment can be entered:
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The comment field will automatically contain information about the program and the date.
The contents of this field will be saved along with the absorbance data when a file is generated
with the Save or Save As command.

To start the run, either click the “Run” button in the data window or select the Run
command in the Kinetics menu. As the run progresses, the data table will be automatically
filled with the absorbance values from the spectrophotometer. Under OS 9 or earlier, the
computer will be locked during the run, but under OS X, the program will continue to
execute the run even if the user leaves the application to do other work on the computer.
The run can be aborted by pressing the command and period keys.

When a Beckman DU 600 series spectrophotometer is used, the wavelength dialog box
will appear before the kinetics run begins. This is because of a quirk in the command set for
these spectrophotometers that requires that the wavelength be specified for each absorbance
reading. Enter the correct wavelength and click the “Set” button.

After the run, the “Run” button will be replaced with the “Graph” button. Clicking this
button will redraw the graph for the data window and bring the graph to the front of the
screen.

To set up another kinetics run, select the New command in the File menu. The param-
eters from the last executed run will be used as the defaults for the new data window.

4.2 The Kinetics Settings Dialog Window

The parameters for a kinetics run can be changed by selecting the Settings... item in the
Kinetics menu, which opens a dialog box:

The following settings can be changed:

• The number of cuvettes from which absorbance measurements should be recorded,
ranging from 1 to the maximum number for the spectrophotometer being used.

• The time interval between readings for each cuvette. This can be specified in either
minutes or seconds. There is a minimum interval that depends on the spectropho-
tometer model and the number of cuvettes being used. If your choice is less than this
minimum, a dialog box will appear when you click OK. The dialog will indicate the
minimum interval for the currently set spectrophotometer and number of cuvettes.
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If only one cuvette is being used, intervals as short as 5 sec can be used. When more
than one cuvette is used, extra time has to be allowed to move the cuvette holder and
take measurements for the other cuvettes.

When the program is in demo mode, the interval can be as short as 1 sec.

• The total time over which data are recorded for each cuvette, in the same units as
specified for the interval between measurements.

• Subtract 1st reading. For many kinetics experiments, only the rate of change in ab-
sorbance is really important, and it may be convenient to express all of the measure-
ments as a difference from the absorbance at time zero. When the Yes button is
selected, the first data point for each cuvette will be set to 0, and all subsequent points
will be recorded as a difference from the initial value. If the No button is selected, the
absorbance values will be recorded directly.

After making any changes, click on the OK button to save the changes or the Cancel
button to close the dialog box without saving the changes. The frontmost data window will
be updated to reflect any changes.

5 Graphs

5.1 The Graph Window

At the end of a kinetics run, the absorbance data will be automatically plotted as a function
of time:
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The axes are automatically scaled, with the labels in scientific notation. The power of ten
(if it is other than 0) is indicated at the top of the absorbance axis or the far right of the
time axis.

The data for each cuvette are also automatically analyzed by least-squares linear regres-
sion, and the table at the bottom of the graph includes the following information:

• The intercept of the least-squares line on the absorbance axis, representing the esti-
mated absorbance at time zero.

• The slope of the least-squares line, representing the estimated rate of absorbance per
time unit (min or sec).

• The rate expressed as a percentage of that for cuvette 1.

• The correlation coefficient, R2. This is a statistical parameter that reflects how well the
experimental data are fit by the line. A value of 1 indicates a perfect fit, and a value of
0 indicates that there is no correlation between the absorbance values and time. More
precisely, R2 indicates the fraction of the variation in the independent variable that is
accounted for by the fit linear function.

5.2 The Graph Menu

The appearance of the graph can be customized a bit using the Graph menu items:

The Lines submenu:
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offers three three choices: The least-squares line, line segments drawn from one time point
to the next or no lines.

The Point Size submenu menu

offers four choices for the size of the symbols used to plot the data.
For more elaborate graphs or data analysis, the data can be saved in a text file and

transferred to a graphing or spreadsheet program, as described in the following section.
The graph window cannot be saved, but it can always be regenerated by clicking on the

“Graph” button in the data window.
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6 The File Menu

The File menu contains the basic commands to open, save or print files:

Only a few comments are necessary about these commands:

• The New command creates a new data window for a kinetics run.

• The Open command opens a previously saved data file. Graphs cannot be saved or
opened, but they can be regenerated by clicking on the “Graph” button of the data
window.

• The Close command closes the frontmost data or graph window.

• The Save and Save As... command is only active when the frontmost window is a
data window. The data in the window are saved as a simple tab delimited text file.
This file can either be reopened in MacSpec or opened in a graphing or spreadsheet
program, or a word processor. The text in the comment box is saved at the top of the
file, with each line prefixed with the “#” character.

• The Print command is used to print the contents of either data or graph windows.
When the data window is printed, the output includes the data table, the contents of
the comment box and the linear regression results from the graph window. When a
graph window is printed, the output includes the graph, linear regression statistics and
the comments.

• The Page Setup command is not currently active.
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7 Editing Data

After a kinetics run is completed the Lock Data item in the Edit menu will become activated:

Selecting this item will remove the checkmark and allow the user to edit the contents of
the data window. Only the absorbance values can be changed. The major use of this feature
is to delete an aberrant data point, such as might arise from a failure of the cuvette positioner.
The inclusion of this feature is not meant as an endorsement of data manipulation!
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